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Important Information

Warranty

The GPIB hardware is warranted against defects in materials and workmanship for a period of two years from the date of 
shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace 
equipment that proves to be defective during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming 
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced 
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not 
execute programming instructions if National Instruments receives notice of such defects during the warranty period. 
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside 
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs 
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully reviewed 
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should 
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages 
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. 
Any action against National Instruments must be brought within one year after the cause of action accrues. National 
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty 
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product; 
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or 
other events outside reasonable control.

Copyright

Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, 
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without 
the prior written consent of National Instruments Corporation.

Trademarks

CVI™, HS488™, LabVIEW™, NAT4882™, natinst.com™, NI-488™, NI-488.2™, NI-488.2M™, TNT4882™C, and 
Turbo488™ are trademarks of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS

National Instruments products are not designed with components and testing intended to ensure a level of reliability 
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving medical 
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part of the 
user or application designer. Any use or application of National Instruments products for or involving medical or clinical 
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeguards, 
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should always 
continue to be used when National Instruments products are being used. National Instruments products are NOT intended 
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard human health 
and safety in medical or clinical treatment.



 

  FCC/DOC Radio Frequency Interference 
Class B Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance 
with the instructions in this manual, may cause interference to radio and television reception. Classification 
requirements are the same for the Federal Communications Commission (FCC) and the Canadian 
Department of Communications (DOC). This equipment has been tested and found to comply with the 
following two regulatory agencies:

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant 
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instructions, may cause harmful interference 
to radio communications. However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is encouraged to try to correct the interference 
by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

Notices to User: Changes or modifications not expressly approved by National Instruments could void 
the user’s authority to operate the equipment under the FCC Rules.

This device complies with the FCC rules only if used with shielded interface cables 
of suitable quality and construction. National Instruments used such cables to test 
this device and provides them for sale to the user. The use of inferior or nonshielded 
interface cables could void the user’s authority to operate the equipment under the 
FCC rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional 
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home 
Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government 
Printing Office, Washington, DC 20402.

Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur 
du Canada.
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About

This

Manual

This manual contains instructions for installing and configuring the 

National Instruments AT-GPIB/TNT+ interface and the GPIB software for 

Windows NT. The GPIB software is intended for use with Windows NT 

version 4.0 or higher.

This manual assumes that you are already familiar with Windows NT.

How to Use the Manual Set

Use this getting started manual to install and configure your 

AT-GPIB/TNT+ and the GPIB software for Windows NT.

Use the GPIB User Manual for Windows 95 and Windows NT to learn the 

basics of GPIB and how to develop an application program. This manual 

also contains application examples and troubleshooting information.

GPIB User
Manual for

Windows 95
and Windows NT

Application
Development
and Examples

NI-488.2M Function
Reference Manual

for Win32

Function
and Routine
Descriptions

Novice
Users

Experienced
Users

Getting Started
Manual

Installation and
Configuration
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About This Manual

The NI-488.2M Function Reference Manual for Win32 contains specific 

NI-488 function and NI-488.2 routine information, such as format, 

parameters, and possible errors.

Organization of This Manual

The Getting Started with Your AT-GPIB/TNT+ and the GPIB Software for 

Windows NT manual is organized as follows:

• Chapter 1, Introduction, explains how to use this manual, lists what 

you need to get started, and briefly describes the AT-GPIB/TNT+ 

board and the GPIB software.

• Chapter 2, GPIB Software Installation, describes how to install the 

GPIB software and GPIB Analyzer software for Windows NT.

• Chapter 3, Plug and Play Software Installation, describes how to 

install the ISA Plug and Play software on your system.

• Chapter 4, Hardware Installation, describes how to install your 

AT-GPIB/TNT+ board.

• Chapter 5, Software Configuration, describes how to configure the 

GPIB software and GPIB Analyzer software for Windows NT.

• Chapter 6, Verify the Installation, describes how to verify the hardware 

and software installation.

• Chapter 7, Begin to Use the GPIB Software, helps you get started with 

the GPIB software for Windows NT.

• Chapter 8, Begin to Use the GPIB Analyzer Software, helps you get 

started with the GPIB Analyzer software for Windows NT.

• Appendix A, Uninstalling the Hardware and Software, describes how 

to uninstall your AT-GPIB/TNT+, the GPIB software, and GPIB 

Analyzer software from Windows NT.

• Appendix B, Troubleshooting and Common Questions, describes how 

to troubleshoot problems and answers some common questions.

• Appendix C, Specifications, describes the electrical, physical, and 

environmental characteristics of the AT-GPIB/TNT+ and the 

recommended operating conditions.

• Appendix D, Customer Communication, contains forms you can use to 

request help from National Instruments or to comment on our products 

and manuals.

• The Glossary contains an alphabetical list and description of terms that 

appear in this manual, including abbreviations, acronyms, metric 

prefixes, mnemonics, and symbols.
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About This Manual

Conventions Used in This Manual

The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options»Substitute 

Fonts directs you to pull down the File menu, select the Page Setup item, 

select Options, and finally select the Substitute Fonts options from the 

last dialog box.

This icon to the left of bold italicized text denotes a note, which alerts you 

to important information.

This icon to the left of bold italicized text denotes a caution, which advises 

you of precautions to take to avoid injury, data loss, or a system crash.

bold Bold text denotes the names of menus, menu items, parameters, dialog 

boxes, dialog box buttons or options, icons, windows, Windows 95 tabs, or 

LEDs.

bold italic Bold italic text denotes an activity objective, note, caution, or warning.

IEEE 488 and IEEE 488 and IEEE 488.2 refer to the ANSI/IEEE Standard 488.1-1987

IEEE 488.2 and the ANSI/IEEE Standard 488.2-1992, respectively, which define the 

GPIB.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 

to a key concept. This font also denotes text from which you supply the 

appropriate word or value, as in Windows 3.x.

monospace Text in this font denotes text or characters that you should literally enter 

from the keyboard, sections of code, programming examples, and syntax 

examples. This font is also used for the proper names of disk drives, paths, 

directories, programs, subprograms, subroutines, device names, functions, 

operations, variables, filenames and extensions, and for statements and 

comments taken from programs.

monospace italic Italic text in this font denotes that you must enter the appropriate words or 

values in the place of these items.

!
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About This Manual

Related Documentation

The following documents contain information that you may find helpful as 

you read this manual:

• ANSI/IEEE Standard 488.1-1987, IEEE Standard Digital Interface 

for Programmable Instrumentation

• ANSI/IEEE Standard 488.2-1992, IEEE Standard Codes, Formats, 

Protocols, and Common Commands

• Microsoft Windows NT System Guide, Microsoft Corporation

Customer Communication

National Instruments wants to receive your comments on our products 

and manuals. We are interested in the applications you develop with our 

products, and we want to help if you have problems with them. To make it 

easy for you to contact us, this manual contains comment and configuration 

forms for you to complete. These forms are in Appendix D, Customer 

Communication, at the end of this manual.
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Chapter

1Introduction

This chapter explains how to use this manual, lists what you need to get 

started, and briefly describes the AT-GPIB/TNT+ board and the GPIB 

software.

How to Use This Manual
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No
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What You Need to Get Started

Make sure you have all of the following items before you install your GPIB 

hardware and software for Windows NT:

❑ AT-GPIB/TNT+ board

❑ The following 3.5 in., high density (1.44 MB) disks, which your kit 

contains:

GPIB Software and GPIB Analyzer Software for Windows NT 

(Disk 1 of 3)

GPIB Software and GPIB Analyzer Software for Windows NT 

(Disk 2 of 3)

GPIB Software and GPIB Analyzer Software for Windows NT 

(Disk 3 of 3)

❑ Windows NT version 4.0 or higher installed on your system

Optional Equipment

Call National Instruments for more information about the following 

optional equipment:

• Serial or parallel bus extender and cables

• Bus expander/isolator

GPIB Hardware Overview

The AT-GPIB/TNT+ hardware complies with the Plug and Play ISA 

Standard. It is completely software configurable. The AT-GPIB/TNT+ 

board, equipped with the TNT4882C ASIC, uses the GPIB software to 

transform any ISA or EISA bus computer into a fully functional GPIB 

Talker/Listener/Controller with complete communications and bus 

management capability. The TNT4882C chip combines the circuitry of the 

NAT4882 ASIC, the Turbo488 performance-enhancing ASIC, and GPIB 

transceivers to create a single-chip IEEE 488.2 Talker/Listener/Controller 

interface. The TNT4882C also implements the HS488 high-speed protocol, 

which increases the maximum data transfer rate of the AT-GPIB/TNT+ 

to 2.2 Mbytes/s, when used in an ISA bus. For more information about 

HS488, refer to Chapter 7, GPIB Programming Techniques, in the GPIB 

User Manual for Windows 95 and Windows NT.
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The AT-GPIB/TNT+ combines the abilities of the GPIB Controller and a 

complete GPIB Analyzer into a single interface. This interface offers a 

low-cost, high-speed alternative to GPIB Controllers and Analyzers 

packaged separately. Because this interface supports both the GPIB 

software and the GPIB Analyzer, you can develop your application and 

perform low-level GPIB system analysis using the same computer.

The AT-GPIB/TNT+ board is fully compatible with all versions of 

AT-GPIB hardware. You can use standard GPIB cables to connect the 

AT-GPIB/TNT+ with up to 14 instruments. If you want to use more than 

the maximum number of instruments, you can order a bus extender or 

expander from National Instruments. Refer to Appendix C, Specifications, 

for more information about the hardware specifications and recommended 

operating conditions.

GPIB Software Overview

The GPIB software for Windows NT includes two components: the GPIB 

driver and utilities and the GPIB Analyzer software.

GPIB Software for Windows NT
The GPIB software for Windows NT includes a loadable Windows NT 

kernel device driver and supporting utilities.

The GPIB software includes the following components:

• Device driver

• Diagnostic test utility

• Configuration utility

• Interactive control program

• Utilities for software development and debugging

• Language interface libraries for Microsoft Visual C/C++ 2.0 or 

later, Borland C/C++ 4.0 or later, and Microsoft Visual Basic 4.0 

or later

• Virtual device driver and special DOS and Windows 3 drivers for 

running existing NI-488.2 for DOS and Windows 3 applications under 

Windows NT

• Example programs that use NI-488 functions and NI-488.2 routines
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For a detailed list of files, refer to Chapter 1, Introduction, in the GPIB 

User Manual for Windows 95 and Windows NT. Refer to Appendix C, 

Specifications, for information about the GPIB software transfer rates.

GPIB Analyzer Software for Windows NT
The GPIB Analyzer software, available with the AT-GPIB/TNT+ 

hardware, can capture, monitor, and participate in bus activity on the GPIB. 

You can also use the GPIB+ hardware and GPIB Analyzer software to 

troubleshoot a variety of IEEE 488 hardware and software problems. The 

GPIB Analyzer can help you solve GPIB communication problems such as 

addressing inconsistencies, protocol violations, and simple bus timeout 

conditions. The built-in timestamping capability can be used to benchmark 

GPIB applications.

The GPIB Analyzer consists of the following components:

• GPIB Analyzer application

• GPIB Analyzer device drivers

• GPIB Analyzer online help

• LabWindows/CVI Run-Time System (used by the GPIB Analyzer)

For more information about using the GPIB Analyzer, refer to the GPIB 

Analyzer online help or the GPIB Analyzer User Manual. 

Time-Saving Development Tools

Your kit includes the GPIB software for Windows NT. In addition, you 

can order the LabWindows/CVI or LabVIEW software from National 

Instruments to speed your application development time and make it 

easier to communicate with your instruments. 

LabVIEW is an easy-to-use, graphical programming environment you 

can use to acquire data from thousands of different instruments, 

including IEEE 488.2 devices, VXI devices, serial devices, PLCs, and 

plug-in data acquisition boards. After you have acquired raw data, you 

can convert it into meaningful results using the powerful data analysis 

routines in LabVIEW. LabVIEW also comes with hundreds of 

instrument drivers, which dramatically reduce software development 

time, because you do not have to spend time programming the low-level 

control of each instrument.
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LabWindows/CVI is similar to LabVIEW, except that it combines an 

interactive, easy-to-use development approach with the programming 

power and flexibility of compiled ANSI C code.

For ordering information, or to request free demonstration software, 

contact National Instruments.
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Chapter

2GPIB Software Installation

This chapter describes how to install the GPIB software and GPIB 

Analyzer software for Windows NT.

Before you install and configure your GPIB hardware, complete the 

following steps to install the GPIB software and GPIB Analyzer software 

for Windows NT:

1. Log onto your Windows NT system using the Administrator 

account. The GPIB setup program must have Administrator 

privileges because the program modifies the configuration registry of 

your system.

2. Insert the GPIB Software and GPIB Analyzer Software for 

Windows NT (Disk 1 of 3) into an unused drive.

3. Select Run... from the Start menu.

4. Type the following command in the dialog box:

x:\setup

where x is the letter of the drive containing the distribution disk 

(usually a or b). 
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The software installation begins with the dialog box shown in 

Figure 2-1.

Figure 2-1.  GPIB Software and GPIB Analyzer Software for Windows NT Setup 

Dialog Box

The setup wizard guides you through the necessary steps to install the 

GPIB software and GPIB Analyzer software. To go back and change 

values where appropriate, click on the Back button. To exit the setup 

program at any time, click on the Cancel button.

Next, you need to enable support for ISA Plug and Play hardware in your 

system. Proceed to Chapter 3, Plug and Play Software Installation.
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Chapter

3Plug and Play 
Software Installation

This chapter contains instructions on how to install the ISA Plug and Play 

software on your system.

The AT-GPIB/TNT+ is an ISA Plug and Play interface. By default, 

Windows NT 4.0 does not support ISA Plug and Play hardware. For 

Windows NT to detect and configure the ISA Plug and Play hardware, you 

must enable support for Plug and Play by installing the pnpisa.sys file. 

If the setup program already installed the ISA Plug and Play software, 

proceed to Chapter 4, Hardware Installation. To determine whether the 

ISA Plug and Play software is installed, search for the pnpisa.sys file in 

your Windows NT system32 drivers directory, for example 

c:\windows\system32\drivers. If you find the pnpisa.sys file, the 

ISA Plug and Play software is installed; proceed to Chapter 4, Hardware 

Installation.

Otherwise, complete the following steps to install the pnpisa.sys file:

1. Log onto your Windows NT system using the Administrator 

account. This installation program must have Administrator 

privileges because the program modifies the configuration registry of 

your computer.

2. Insert your Windows NT 4.0 CD-ROM into your CD-ROM drive.

3. Locate the pnpisa.inf file in the Drvlib\Pnpisa\X86 folder on 

the Windows NT 4.0 CD-ROM.

4. Right-click on the pnpisa.inf file and click on the Install button in 

the menu that appears. The installation program takes you through the 

necessary steps to install the pnpisa.sys file.

5. After the installation is complete, restart your system. 

The software installation and enabling of support for ISA Plug and Play 

hardware on your system is now complete. Proceed to Chapter 4, 

Hardware Installation. 
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Chapter

4Hardware Installation

This chapter describes how to install your AT-GPIB/TNT+ board.

Caution Electrostatic discharge can damage several components on your AT-GPIB/TNT+ 

board. To avoid electrostatic damage when you handle the board, touch the 

antistatic plastic package to a metal part of your system chassis before you remove 

the board from the package.

Complete the following steps to install your AT-GPIB/TNT+:

1. Turn off your system. Keep the system plugged in so that it remains 

grounded while you install the AT-GPIB/TNT+.

2. Remove the top cover (or other access panels) to give yourself access 

to the computer expansion slots.

3. Find an unused expansion slot in your computer. The AT-GPIB/TNT+ 

board requires a 16-bit ISA expansion slot. 

4. Remove the corresponding slot cover on the back panel of the 

computer.

!
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5. Insert the AT-GPIB/TNT+ board into the slot with the GPIB connector 

sticking out of the opening on the back panel, as shown in Figure 4-1. 

It might be a tight fit, but do not force the board into place. 

Figure 4-1.  Installing the AT-GPIB/TNT+ Board

6. Screw the mounting bracket of the AT-GPIB/TNT+ board to the back 

panel rail of the computer.

7. Replace the top cover (or the access panel to the expansion slot).

8. Turn on your system and start Windows NT. Windows NT should 

automatically detect the GPIB hardware and briefly display a New 

Hardware Found dialog box. 

9. After Windows NT detects the hardware, a System Settings Change 

dialog box appears. Click on the Yes button to restart your system.

The AT-GPIB/TNT+ board installation is now complete. Proceed to 

Chapter 5, Software Configuration.
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Chapter

5Software Configuration

This chapter describes how to configure the GPIB software and GPIB 

Analyzer software for Windows NT.

By default, Windows NT does not configure ISA Plug and Play hardware. 

The AT-GPIB/TNT+ board is an ISA Plug and Play board and must be 

configured using the GPIB Configuration utility.

Start to Use the GPIB Configuration Utility

The GPIB Configuration utility is an interactive utility you can use to 

examine or modify the configuration of the GPIB driver and GPIB 

Analyzer driver. You must run the GPIB Configuration utility before you 

use the AT-GPIB/TNT+ board. Complete the following steps to run the 

utility:

1. Select Start»Settings»Control Panel and double-click on the GPIB 

icon.

The GPIB Configuration utility displays a list of all the GPIB boards 

and device names. 

2. In the GPIB Configuration dialog box, select a GPIB interface from 

the GPIB Board list. If you are using only one GPIB interface, select 

GPIB0.

3. Click on the Board Type button, select AT-GPIB/TNT+ from the 

Board Type list, and click on the OK button. 

4. Click on the Configure button to bring up the AT-GPIB/TNT+ 

Configuration dialog box, as shown in Figure 5-1. For more 

information about GPIB Configuration utility options, refer to the 

GPIB User Manual for Windows 95 and Windows NT or use the 

online help.
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5. In the AT-GPIB/TNT+ Configuration dialog box, you need to 

configure the Controller and Analyzer resources. Proceed to the next 

section, Configure the Software.

Figure 5-1.  AT-GPIB/TNT+ Configuration Dialog Box

Configure the Software

Configure the GPIB Controller Resources
By default, the Controller for the AT-GPIB/TNT+ board is enabled. If your 

system resources are low and you want to use only the Analyzer 

functionality of the AT-GPIB/TNT+, you can free up resources used by the 

Controller by disabling the Controller functionality. To disable the 

Controller, uncheck the Enable Controller checkbox. If you disable the 

Controller functionality, the GPIB software does not function properly, but 

you can use the GPIB Analyzer software. If you disable the Controller 

functionality, proceed to the next section, Configure the GPIB Analyzer 

Resources.

Otherwise, complete the following steps to configure the GPIB Controller 

resources:

1. In the GPIB Configuration dialog box, click on the Controller 

Resources button.
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2. In the AT-GPIB/TNT+ Properties dialog box that appears, examine 

the assigned resources. Figure 5-2 shows the AT-GPIB/TNT+ 

Properties dialog box. Use the Setting based on drop-down list and 

the Change Setting... button to select conflict-free resources. From the 

Setting based on drop-down list, select either Basic Configuration 

0000 or Basic Configuration 0001, the only two valid basic 

configurations. The valid resources are as follows:

Figure 5-2.  AT-GPIB/TNT+ Properties Dialog Box

a. Reserving a DMA channel is optional. The options for the DMA 

channel are 5, 6, 7, or none. To select a different DMA channel, 

select Direct Memory Access and click on the Change Setting... 

button. To set the DMA channel to None, select Basic 

Configuration 0001 from the Setting based on drop-down list.

b. Reserving address space is mandatory. To select a base I/O 

address, select Input/Output Range and click on the Change 

Setting... button. You must have 0x20 bytes of contiguous I/O 

address space. For example, if you are selecting a base I/O address 

of 0x2C0, enter 2C0 for the start value and enter 2DF for the end 
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value. A base address value of 2C0 usually works with a GPIB 

interface.

c. Reserving an IRQ level is mandatory. To select an IRQ level, 

select Interrupt Request and click on the Change Setting... 

button. The options for the IRQ level are 3, 4, 5, 6, 7, 9, 11, 12, 14, 

or 15. An IRQ level of 11 usually works with a GPIB interface.

3. After you change the Controller settings to valid settings and there are 

no resource conflicts, click on the OK button. 

4. When the Creating a Forced Configuration dialog box appears, click 

on the Yes button to confirm the setting of the selected resources.

5. Proceed to the next section, Configure the GPIB Analyzer Resources.

Configure the GPIB Analyzer Resources
By default, the Analyzer for the AT-GPIB/TNT+ board is enabled. If your 

system resources are low and you want to use only the Controller 

functionality of the AT-GPIB/TNT+, you can free up resources used by the 

Analyzer by disabling the Analyzer functionality. To disable the Analyzer, 

uncheck the Enable Analyzer checkbox. If you disable the Analyzer 

functionality, the GPIB Analyzer software does not function properly, but 

you can use the GPIB software. If you disable the Analyzer functionality, 

proceed to the next section, Exit the GPIB Configuration Utility.

Note Only one GPIB Analyzer can be used at a time. If you try to configure a second 

GPIB Analyzer, a warning message pops up, giving you the option to either keep 

your existing GPIB Analyzer enabled, or to enable the new GPIB Analyzer and 

disable the existing one.

Complete the following steps to configure the GPIB Analyzer resources:

1. In the GPIB Configuration dialog box, click on the Analyzer 

Resources button.
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2. In the AT-GPIB/TNT+ Properties dialog box that appears, examine 

the assigned resources. Figure 5-3 shows the AT-GPIB/TNT+ 

Properties dialog box. Use the Setting based on drop-down list and 

the Change Setting... button to select conflict-free resources. From the 

Setting based on drop-down list, select either Basic Configuration 

0000 or Basic Configuration 0001, the only two valid basic 

configurations. The valid resources are as follows:

Figure 5-3.  AT-GPIB/TNT+ Properties Dialog Box

a. Reserving a DMA channel is optional. The options for the DMA 

channel are 5, 6, 7, or none. To select a different DMA channel, 

select Direct Memory Access and click on the Change Setting... 

button. To set the DMA channel to None, select Basic 

Configuration 0001 from the Setting based on drop-down list.

b. Reserving address space is mandatory. To select a base I/O 

address, select Input/Output Range and click on the Change 

Setting... button. You must have 0x20 bytes of contiguous I/O 

address space. For example, if you are selecting a base I/O address 

of 0x280, enter 280 for the start value and enter 29F for the end 
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value. A base address value of 280 usually works with a GPIB 

interface.

c. Reserving an IRQ level is mandatory. To select an IRQ level, 

select Interrupt Request and click on the Change Setting... 

button. The options for the IRQ level are 3, 4, 5, 6, 7, 9, 11, 12, 14, 

or 15. An IRQ level of 5 usually works with a GPIB interface.

3. After you change the Analyzer settings to valid settings and there are 

no resource conflicts, click on the OK button. 

4. When the Creating a Forced Configuration dialog box appears, click 

on the Yes button to confirm the setting of the selected resources.

5. You can either proceed to the next section, Configure Other GPIB 

Software Settings (Optional), or exit the GPIB Configuration utility. To 

exit the utility, refer to the Exit the GPIB Configuration Utility later in 

this chapter.

Configure Other GPIB Software Settings (Optional)
You can configure additional items, such as the GPIB Primary Address or 

I/O Timeout, but they are usually configured at run time by your 

application program. For more information about the GPIB Configuration 

utility options, refer to the online help.

Exit the GPIB Configuration Utility

Complete the following steps to exit the GPIB Configuration utility:

1. In the GPIB Configuration dialog box, click on the OK button to save 

your changes and exit the utility. To discard your current changes and 

exit the utility, click on the Cancel button.

2. Restart Windows NT.

After you configure your GPIB software and GPIB Analyzer software, you 

should verify the installation. Continue to the next chapter, Verify the 

Installation.
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Chapter

6Verify the Installation

This chapter describes how to verify the hardware and software installation. 

You can use the Diagnostic utility, installed with your GPIB software, to 

test the hardware and software installation. The Diagnostic utility verifies 

that your hardware and software are functioning properly and that the 

configuration of your GPIB interfaces does not conflict with anything else 

in your system. 

To run the Diagnostic utility, select the Diagnostic item under 

Start»Programs»GPIB Software.

After you start the Diagnostic utility, test your GPIB interfaces by clicking 

on the Test All button. If the Diagnostic utility test is successful, it puts a 

checkmark next to the interface and changes its status from untested to 

passed. If the Diagnostic utility test fails, it puts an X next to the interface, 

and changes its status from untested to failed. Figure 6-1 shows the 

Diagnostic dialog box after it has tested some GPIB interfaces. The 

AT-GPIB/TNT+ board appears as AT-GPIB/TNT.

Figure 6-1.  Diagnostic Utility after Testing
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To get details on any of the tested GPIB interfaces, select the interface and 

click on the Details button. For each failed GPIB interface, select it and 

click on the Details button to get a description of the failure. Use that 

information and the information in Appendix B, Troubleshooting and 

Common Questions, to troubleshoot the problem. Troubleshooting 

information is also available in the Diagnostic utility online help, which 

you can access by clicking on the Help button.
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Chapter

7Begin to Use the 
GPIB Software

This chapter helps you get started with the GPIB software for 

Windows NT.

Getting Started with LabVIEW

LabVIEW is a graphical programming language in which your source code 

looks like a flowchart. It provides the same functionality as other 

programming languages when controlling GPIB instruments. If you 

already installed LabVIEW, you can use the LabVIEW GPIB functions 

without any additional installation. To learn about the basic concepts of 

GPIB communication, refer to the LabVIEW GPIB functions chapter in the 

LabVIEW User Manual. To learn more about each GPIB function, refer to 

the LabVIEW Function and VI Overview Manual and the online help.

National Instruments provides LabVIEW instrument drivers, which are 

applications that communicate to a specific GPIB instrument. LabVIEW 

instrument drivers eliminate the need to learn the complex, low-level 

programming commands for each instrument.   For more information, refer 

to Chapter 7, Getting Started with a LabVIEW Instrument Driver, in the 

LabVIEW User Manual. If you want to write your own instrument driver, 

National Instruments provides application notes that help you get started.

To find GPIB examples similar to your application, click on the Solution 

Wizard and Search Examples buttons in the startup LabVIEW dialog box.

For more information about NI products, refer to our web site at 

http://www.natinst.com/products/.

Getting Started with LabWindows/CVI

If you already installed LabWindows/CVI, you can use the 

LabWindows/CVI GPIB Library without any additional installation. The 

LabWindows/CVI GPIB Library includes the functions documented in 

your NI-488.2 or NI-488.2M reference manual, as well as several 

additional functions, which are documented in the GPIB library chapter of 
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the LabWindows/CVI Standard Libraries Reference Manual.   To help you 

use the GPIB functions, LabWindows/CVI provides function panels for the 

GPIB Library. To access the function panels, select GPIB/GPIB 488.2 

from the Library menu of the Project or Source windows. For 

information about using function panels, refer to the function panels 

chapter in the LabWindows/CVI User Manual.

If you need to program a GPIB instrument, you might want to use an 

instrument driver. An instrument driver is a set of high-level C functions for 

controlling a specific instrument. The low-level steps to control the 

instrument and read data are encapsulated in the high-level functions. You 

can write an instrument driver yourself, or you can use one that is already 

written. When you purchase LabWindows/CVI, you get free access to a 

library of drivers for hundreds of instruments. For more information about 

instrument drivers, refer to the project window chapter in the 

LabWindows/CVI User Manual.

For more information about NI products, please refer to our web site at 

http://www.natinst.com/products/.

Introduction to the Win32 Interactive Control Utility

You can use the interactive control utility to enter NI-488 functions and 

NI-488.2 routines interactively and see the values returned by the function 

calls. You can use this utility to do the following: 

• Verify GPIB communication with your device quickly and easily.

• Learn the NI-488 functions and NI-488.2 routines before you write 

your application.

• Become familiar with the commands of your device.

• Receive data from your GPIB device.

• Troubleshoot problems with your application.

To run the Win32 Interactive Control utility, select the Win32 Interactive 

Control item under Start»Programs»GPIB Software. 

This utility includes extensive online help, which you can access by 

entering help at the : prompt. For more information about the Win32 

Interactive Control utility, refer to the GPIB User Manual for Windows 95 

and Windows NT.
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Introduction to the NI Spy Utility

Included with the GPIB software is NI Spy, a Win32 utility that monitors 

and records multiple National Instruments APIs (for example, NI-488.2 

and VISA). You can use NI Spy to monitor Win32, Win16, and DOS GPIB 

applications. Use NI Spy to do the following: 

• Capture information about NI-488 functions and NI-488.2 routines as 

your GPIB applications invoke them.

• Display captured information, including, but not limited to, input and 

output parameter values, I/O buffer contents, and return values.

• Save, restore, and print captured information.

To run NI Spy, select the NI Spy item under Start»Programs»GPIB 

Software. 

For more information about the NI Spy utility, refer to Chapter 5, NI Spy 

Utility, in the GPIB User Manual for Windows 95 and Windows NT, or use 

its built-in, context-sensitive online help.

Running Existing GPIB Applications

You can run existing Win32, Win16, and DOS GPIB applications under 

Windows NT. 

Win32 and Win16 GPIB applications run without any special 

modifications. To run an existing DOS GPIB application, complete the 

following steps.

Load the special GPIB device driver gpib-nt.com instead of gpib.com, 

which you normally use with DOS. When you install the GPIB software, 

the GPIB setup program copies gpib-nt.com into a new subdirectory 

called doswin16. To use gpib-nt.com, you must modify your 

config.nt file to load gpib-nt.com whenever a DOS application runs. 

The config.nt file is located in your winnt\system32 directory, where 

winnt is your Windows NT directory, for example, c:\windows. The 

GPIB setup program modifies the config.nt file by adding the following 

lines:

REM *** To run DOS GPIB applications, uncomment the 

REM *** following line

REM device=path\doswin16\gpib-nt.com
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where path is the directory in which you installed the GPIB software.

To load gpib-nt.com, locate these lines in your config.nt file and 

delete REM from the third line, as follows:

REM *** To run DOS GPIB applications, uncomment the 

REM *** following line

device=path\doswin16\gpib-nt.com

where path is the directory in which you installed the GPIB software.

General Programming Considerations

As you begin developing your Win32 GPIB application, remember the 

following points:

• For your C/C++ application, you must include the NI-488.2M header 

file, decl-32.h, in your source code. 

• You can access the GPIB software through the 32-bit DLL, 

gpib-32.dll, either by linking with one of the language interfaces 

provided with the GPIB software, or by using direct DLL entry from 

other programming environments.

• Several sample GPIB applications are included with the GPIB 

software. Use these as a guide for your own application development.

For information about choosing a programming method, developing your 

application, or compiling and linking, refer to the GPIB User Manual for 

Windows 95 and Windows NT. For detailed information about each NI-488 

function and NI-488.2 routine, refer to the NI-488.2M Function Reference 

Manual for Win32 or the online help.
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Chapter

8Begin to Use the GPIB 
Analyzer Software

This chapter helps you get started with the GPIB Analyzer software for 

Windows NT.

To start the GPIB Analyzer, select the GPIB Analyzer item under 

Start»Programs»GPIB Analyzer Software.

The GPIB Analyzer hardware of the AT-GPIB/TNT+ can analyze all GPIB 

activity. To access this hardware, you can use the GPIB Analyzer 

Windows NT application. Because the GPIB Analyzer monitors the actual 

GPIB signals, it provides the best mechanism for debugging and optimizing 

a GPIB system. You can use the GPIB Analyzer to do the following:

• Verify that an NI-488 or NI-488.2 application is communicating on the 

bus as expected.

• Determine if a GPIB device is properly conforming to the protocol, 

and if not, find possible solutions.

• Analyze performance of a GPIB system and determine how each 

device affects performance.

• Resolve timeout problems related to nonresponsive GPIB devices.

• Determine the cause of missing bytes in a data stream.

• Resolve problems related to standard IEEE 488 3-wire handshaking or 

the new high-speed HS488 handshaking protocols.

• Debug bus problems by manually controlling GPIB signal lines.

For more information about the GPIB Analyzer, refer to the GPIB Analyzer 

User Manual or use the online help.
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Appendix

AUninstalling the 
Hardware and Software

This appendix describes how to uninstall your AT-GPIB/TNT+, the GPIB 

software, and GPIB Analyzer software from Windows NT.

Uninstalling the Hardware

Before you physically remove the GPIB hardware from your system, you 

must remove the hardware information using the GPIB Configuration 

utility. Complete the following steps to remove the hardware information:

1. Select Start»Settings»Control Panel and double-click on the GPIB 

icon.

2. In the GPIB Configuration dialog box, select the GPIB interface you 

want to remove from the GPIB Board list.

3. Click on the Board Type button and select None from the list that 

appears, as shown in Figure A-1. Click on the OK button to save the 

new Board Type setting.

Figure A-1.  Board Type Dialog Box

4. Click on the OK button to save your changes and exit the GPIB 

Configuration utility.

5. Shut down Windows NT, turn off your system, and physically remove 

the interface from your system.
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Uninstalling the Software

Before you uninstall the GPIB software and GPIB Analyzer software, you 

should set the Board Type for your GPIB interface(s) to None in the GPIB 

Configuration utility, as described in the previous section. Complete the 

following steps to uninstall the GPIB software and GPIB Analyzer 

software:

1. Select Start»Settings»Control Panel and double-click on the 

Add/Remove Programs icon. The dialog box shown in Figure A-2 

lists the software available for removal.

Figure A-2.  Add/Remove Programs Properties Dialog Box
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2. Select the GPIB software and GPIB Analyzer software you want to 

remove and click on the Add/Remove… button. The uninstall 

program removes all folders, programs, DLLs, and registry entries 

associated with the GPIB software and GPIB Analyzer software. 

During uninstallation, you are prompted about deleting shared 

components, as shown in Figure A-3. Click on Yes, No, or No to All 

to continue with the uninstallation.

Figure A-3.  Removed Shared Component Dialog Box

If you have not physically removed your hardware, shut down 

Windows NT, turn off your system, and remove the GPIB hardware.

The uninstall program removes only items that the GPIB setup program 

installed. If you add anything to a directory created by the GPIB setup 

program, the uninstall program does not delete that directory. You need to 

remove any remaining components yourself.

If you want to reinstall the GPIB hardware, GPIB software, and GPIB 

Analyzer software, refer to Chapter 2, GPIB Software Installation, 

Chapter 3, Plug and Play Software Installation, and Chapter 4, 

Hardware Installation.
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Appendix

BTroubleshooting and 
Common Questions

This appendix describes how to troubleshoot problems and answers some 

common questions.

Troubleshooting Diagnostic Utility Failures

The following sections explain common error messages generated by the 

Diagnostic utility.

Missing Software Components
This error occurs if the software components that are necessary for the 

GPIB software for Windows NT to function correctly are not present in the 

system. If you encounter this problem, reinstall the GPIB software for 

Windows NT and run the Diagnostic utility again.

No GPIB Interfaces Present
This error occurs if there are no GPIB interfaces physically present in the 

system or if there is a resource conflict with the interfaces that are installed. 

If you encounter this problem, use the GPIB Configuration utility to 

examine the installed GPIB interfaces and the resources assigned to each. 

Then, run the Diagnostic utility again.

To access this information in the GPIB Configuration utility, complete the 

following steps:

1. Select Start»Settings»Control Panel and double-click on the GPIB 

icon.

2. Click on the Board Type button and verify that the type of GPIB 

interface listed for each logical board name is correct. Click on the OK 

button to return to the main dialog box.

3. Double-click on each board name and verify that the hardware settings 

displayed in the dialog box match your actual hardware settings.

Note If you disable the Controller functionality of the AT-GPIB/TNT+ board, the 

Diagnostic utility cannot detect the board.
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GPIB Cables Need To Be Disconnected
This error occurs if you have any GPIB cables connected to the GPIB 

interface. Disconnect all GPIB cables and run the Diagnostic utility again.

Address Resource Conflict
This error occurs if the address resources assigned to a GPIB interface 

conflict with the address resources being used by other devices in the 

system. To resolve an address resource conflict, refer to the Resolving 

Resource Conflicts section later in this appendix. After you have resolved 

the conflict, run the Diagnostic utility again.

Interrupt Resource Conflict
This error occurs if the interrupt resources assigned to a GPIB interface 

conflict with the interrupt resources being used by other devices in the 

system. To resolve an interrupt resource conflict, refer to the Resolving 

Resource Conflicts section later in this appendix. After you have resolved 

the conflict, run the Diagnostic utility again.

DMA Resource Conflict
This error occurs if the DMA resources assigned to a GPIB interface 

conflict with the DMA resources being used by other devices in the system. 

To resolve a DMA resource conflict, refer to the Resolving Resource 

Conflicts section later in this appendix. After you have resolved the 

conflict, run the Diagnostic utility again.

Single-Cycle DMA Required
This error occurs if the Diagnostic utility detects that it is unable to perform 

demand-mode DMA for the GPIB interface and that you have not 

configured the GPIB software to use single-cycle DMA. GPIB interfaces 

that use the system DMA controller, such as the AT-GPIB/TNT+, normally 

use demand-mode DMA. If you encounter this error, you should use the 

GPIB Configuration utility to configure the GPIB software to use 

single-cycle DMA for all DMA transfers, and then run the Diagnostic 

utility again.
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To configure the GPIB software to use single-cycle DMA for a particular 

GPIB interface, complete the following steps:

1. Select Start»Settings»Control Panel and double-click on the GPIB 

icon.

2. Double-click on the GPIB interface you want to configure.

3. Make sure that the Use Demand Mode DMA item is unchecked.

GPIB Software Problem Encountered
This error occurs if the Diagnostic utility detects that it is unable to 

communicate correctly with the GPIB hardware using the installed GPIB 

software and GPIB Analyzer software. If you encounter this error, shut 

down your system, restart it, and run the Diagnostic utility again. If the 

problem persists, reinstall the GPIB software and GPIB Analyzer software 

for Windows NT. 

Unknown Problem Encountered
This error occurs if an unknown problem is encountered when you try to 

execute the Diagnostic utility. If this error occurs, shut down your 

computer, restart it, and run the Diagnostic utility again. If the problem 

persists, reinstall the GPIB software for Windows NT. 

Resolving Resource Conflicts

Resource conflicts occur when your system contains hardware that is 

configured to use the same resources as your GPIB interface. The GPIB 

driver and GPIB Analyzer driver detect some resource conflicts when they 

load. When the drivers detect conflicts as they load, they record an error 

message describing the conflict. You can use the Event Viewer, as 

described in the following section, Using Windows NT Diagnostic Tools, to 

see which resource is in conflict.

Once you have identified the resource that caused the conflict, use the GPIB 

Configuration utility to reconfigure your GPIB interface so that it uses 

conflict-free resources. To help in the selection of conflict-free resources, 

Microsoft has provided a utility called Windows NT Diagnostics. This 

utility displays a list of the I/O port addresses, interrupt levels, and DMA 

channels that your system is currently using. You can assign resources not 

listed by this utility to your GPIB interface.

To run the Windows NT Diagnostics utility, select 

Start»Programs»Administrative Tools»Windows NT Diagnostics.
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Using Windows NT Diagnostic Tools

There are many reasons why the GPIB driver and GPIB Analyzer driver 

might not load. If the software is not properly installed or if there is a 

conflict between the GPIB hardware and the other hardware in the system, 

the GPIB driver and/or GPIB Analyzer driver fails to start. Two 

Windows NT utilities are useful in determining the source of the problem: 

the Devices applet in the Control Panel, and the Event Viewer. The 

following sections describe the information available through each utility.

Examining NT Devices To Verify the GPIB Installation
To verify whether the GPIB devices are installed correctly (that is, that the 

devices are started), select Start»Settings»Control Panel and 

double-click on the Devices icon. 

This utility lists all of the devices detected by Windows NT. Each device 

has a status associated with it. If the GPIB driver is installed correctly, the 

following lines appear in the list of Windows NT devices:

Device Status Started

GPIB Analyzer Driver Started Automatic

GPIB Board Class Driver Started Automatic

GPIB Device Class Driver Started Automatic

You should also see one or more lines similar to the following:

Device Status Started

GPIB Port Driver (AT-GPIB) **** System

GPIB Port Driver (PCI-GPIB) **** System

The GPIB Board Class Driver, the GPIB Device Class Driver, and at least 

one of the GPIB Port Drivers listed by the Devices applet should have a 

status of Started. If not, refer to the next section, Examining the NT 

System Log Using the Event Viewer.

If the GPIB Class Driver lines are not present, or if the GPIB Analyzer 

Driver line or at least one GPIB Port Driver line is not present, the GPIB 

software and GPIB Analyzer software is not installed properly. You should 

reinstall the GPIB software and GPIB Analyzer software. Refer to 

Chapter 2, GPIB Software Installation, for installation instructions.
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Examining the NT System Log Using the Event Viewer
Windows NT maintains a system log. If the GPIB driver and GPIB 

Analyzer driver are unable to start, it records entries in the system log 

explaining why the drivers failed to start. To examine the system log by 

running the Event Viewer utility, select Start»Programs»Administrative 

Tools»Event Viewer.

Events that might appear in the system log include the following:

• The system cannot locate the device file for one or more of the devices 

that make up the GPIB driver and GPIB Analyzer driver, and an event 

is logged that The system cannot find the file specified. 

In this case, the GPIB software and GPIB Analyzer software is not 

installed properly. You should reinstall the GPIB software and GPIB 

Analyzer software. Refer to Chapter 2, GPIB Software Installation, for 

installation instructions.

• A conflict exists between the GPIB hardware and the other hardware 

in the system. If this is the case, an event is logged that indicates the 

nature of the resource conflict. To correct this conflict, reconfigure the 

GPIB software and GPIB Analyzer software. Refer to Chapter 5, 

Software Configuration, for configuration information.

Common Questions

GPIB Hardware and Software Questions

How can I determine which version of the GPIB software I have 

installed?

Run the Diagnostic utility: select the Diagnostic item under 

Start»Programs»GPIB Software. The Diagnostic utility displays the 

version of the GPIB software that is installed in a banner at the bottom 

of the window that appears.

How many GPIB interfaces can I configure for use with my GPIB 

software for Windows NT?

You can configure the GPIB software for Windows NT to communicate 

with up to four GPIB interfaces.
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How many devices can I configure for use with my GPIB software for 

Windows NT?

The GPIB software for Windows NT provides a total of 100 logical devices 

for applications to use. The default number of devices is 32.

Are interrupts and DMA required with the GPIB software for 

Windows NT?

Interrupts are required, but DMA is not.

How can I determine if my GPIB hardware, GPIB software, and 

GPIB Analyzer software are installed properly?

Run the Diagnostic utility: select the Diagnostic item under 

Start»Programs»GPIB Software. Refer to the Troubleshooting 

Diagnostic Utility Failuressection earlier in this appendix or the online 

help to troubleshoot any problems.

Why does my AT-GPIB/TNT+ board appear as AT-GPIB/TNT in the 

Diagnostic utility?

The AT-GPIB/TNT+ and AT-GPIB/TNT boards are equivalent from a 

GPIB Controller point of view.

I am low on system resources. What can I do?

If your system is low on resources (for example, interrupts or DMA), you 

can disable the Controller or Analyzer functionality of your 

AT-GPIB/TNT+. If you disable the Controller functionality, the GPIB 

software does not function properly and the Bus Monitor functionality is 

disabled in the GPIB Analyzer application. If you disable the Analyzer 

functionality, the GPIB Analyzer software does not function properly. If 

you do not want to disable the Controller or Analyzer, you can free up other 

resources in your system and reconfigure your AT-GPIB/TNT+.

When should I use the Win32 Interactive Control utility?

You can use the Win32 Interactive Control utility to test and verify 

instrument communication, troubleshoot problems, and develop your 

application. For more information, refer to the Introduction to the Win32 

Interactive Control Utility section in Chapter 7, Begin to Use the 

GPIB Software.
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How do I use an NI-488.2M language interface?

For information about using NI-488.2M language interfaces, refer to 

Chapter 3, Developing Your Application, in the GPIB User Manual for 

Windows 95 and Windows NT.

What do I do if the Diagnostic utility fails with an error?

Use the Diagnostic utility online help, or refer to the Troubleshooting 

Diagnostic Utility Failures section earlier in this appendix. If you have 

already completed the troubleshooting steps, fill out the forms in 

Appendix D, Customer Communication, and contact National Instruments.

How do I communicate with my instrument over the GPIB?

Refer to the documentation that came from the instrument manufacturer. 

The command sequences you use are totally dependent on the specific 

instrument. The documentation for each instrument should include the 

GPIB commands you need to communicate with it. In most cases, NI-488 

device-level calls are sufficient for communicating with instruments. Refer 

to Chapter 3, Developing Your Application, in the GPIB User Manual for 

Windows 95 and Windows NT, for more information.

Can I use the NI-488 and NI-488.2 calls together in the same 

application?

Yes, you can mix NI-488 functions and NI-488.2 routines.

What can I do to check for errors in my GPIB application?

Examine the value of ibsta after each NI-488 or NI-488.2 call. If a call 

fails, the ERR bit of ibsta is set and an error code is stored in iberr. For 

more information about global status variables, refer to Chapter 3, 

Developing Your Application, in the GPIB User Manual for Windows 95 

and Windows NT.

What information should I have before I call National Instruments?

When you call National Instruments, you should have the results of the 

Diagnostic utility test. Also, make sure you have filled out the forms in 

Appendix D, Customer Communication.
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GPIB Analyzer Questions
Which GPIB hardware products support the GPIB Analyzer 

software?

You can use the GPIB Analyzer in Windows NT only if you have an 

AT-GPIB/TNT+ or a PCI-GPIB+, or in Windows 95 only if you have an 

AT-GPIB/TNT+ or a PCMCIA-GPIB+.

How do I use the GPIB Analyzer?

You can use the GPIB Analyzer to capture, monitor, and participate in 

GPIB activity and to help solve problems with IEEE 488 hardware or 

software. For help using the Analyzer, refer to the GPIB Analyzer User 

Manual or use the online help.

Should I run the GPIB Analyzer on a different computer than the one 

my GPIB board is installed in?

You do not have to run the GPIB Analyzer on a separate computer. Because 

the AT-GPIB/TNT+ is a GPIB interface, you can develop your GPIB 

application and use the GPIB Analyzer on the same computer.

Can I use the GPIB Analyzer for debugging if I am not using the 

AT-GPIB/TNT+ in my application?

Yes. If you have an AT-GPIB/TNT+ installed, you can use the GPIB 

Analyzer for applications that use other IEEE 488.2 interface boards. For 

example, you could install the GPIB Analyzer hardware and software on a 

computer that uses some other GPIB interface supported by the GPIB 

software for Windows NT. You could then use the GPIB Analyzer to debug 

applications that use the other GPIB interface.

When I start the GPIB Analyzer, why do I get the following message: 

LabWindows/CVI requires a math coprocessor?

For the GPIB Analyzer to function properly under Windows NT, your 

computer must have a math coprocessor.
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Can I disable the GPIB Analyzer or GPIB Controller functionality of 

my AT-GPIB/TNT+ if I am not using it?

Yes. For example, if you have two GPIB+ interfaces on your system, only 

one can be used as a GPIB Analyzer, so you should disable the GPIB 

Analyzer on the other interface. To do so, complete the following steps:

1. Select Start»Settings»Control Panel and double-click on the GPIB 

icon. 

2. Select the appropriate GPIB interface from the GPIB Board list and 

click on the Configure button.

3. To disable the Analyzer functionality on your GPIB interface, uncheck 

the Enable Analyzer checkbox. To disable the Controller 

functionality on your GPIB interface, uncheck the Enable Controller 

checkbox.

4. Click on the OK button.

5. In the GPIB Configuration dialog box, click on the OK button to save 

your changes and exit the GPIB Configuration utility.

I am low on system resources. What can I do?

If your system is low on resources (for example, interrupts or DMA), you 

can disable the Controller or Analyzer functionality of your 

AT-GPIB/TNT+. If you disable the Controller functionality, the GPIB 

software does not function properly and the Bus Monitor functionality is 

disabled in the GPIB Analyzer application. If you disable the Analyzer 

functionality, the GPIB Analyzer software does not function properly. If 

you do not want to disable the Controller or Analyzer, you can free up other 

resources in your system and reconfigure your AT-GPIB/TNT+.

Why does the uninstall program leave some components installed?

The uninstall program removes only items that the installation program 

installed. If you add anything to a directory that was created by the 

installation program, the uninstall program does not delete that directory, 

because it is not empty after the uninstallation. You need to remove the 

directory and any remaining components in that directory.

What information should I have before I call National Instruments?

When you call National Instruments, you should have the results of the 

Diagnostic utility test. Also, make sure you have filled out the forms in 

Appendix D, Customer Communication.
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Appendix

CSpecifications

This appendix describes the electrical, physical, and environmental 

characteristics of the AT-GPIB/TNT+ and the recommended operating 

conditions.

Hardware Characteristics

Table C-1.  Hardware Characteristics for the AT-GPIB/TNT+

Characteristic Specification

Dimensions 10.67 by 16.51 cm 

(4.2 by 6.5 in.)

Power Requirement

(from PC AT I/O channel)

+5 VDC 120 mA Typical

200 mA Maximum

I/O Connector IEEE 488 Standard 24-Pin

Operating Environment:

   Component Temperature

   Relative Humidity

0° to 55° C

10% to 90%, noncondensing

Storage Environment:

   Temperature

   Relative Humidity

–20° to 70° C

5% to 90%, noncondensing

EMI FCC Class B Certified
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Software Transfer Rates

Table C-2.  GPIB Software Transfer Rates for the AT-GPIB/TNT+

Transfer Method

Maximum GPIB

Transfer Rate

3-wire (IEEE 488) 1.5 Mbytes/s*

High Speed (HS488) 2.2 Mbytes/s*

* Actual speed may vary considerably from speed shown because of system and

instrumentation capabilities.
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Appendix

DCustomer Communication

For your convenience, this appendix contains forms to help you gather the information necessary 

to help us solve your technical problems and a form you can use to comment on the product 

documentation. When you contact us, we need the information on the Technical Support Form and 

the configuration form, if your manual contains one, about your system configuration to answer your 

questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to quickly 

provide the information you need. Our electronic services include a bulletin board service, an FTP site, 

a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first try the 

electronic support systems. If the information available on these systems does not answer your 

questions, we offer fax and telephone support through our technical support centers, which are staffed 

by applications engineers. 

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of files 

and documents to answer most common customer questions. From these sites, you can also download 

the latest instrument drivers, updates, and example programs. For recorded instructions on how to use 

the bulletin board and FTP services and for BBS automated information, call 512 795 6990. You can 

access these services at:

United States: 512 794 5422

Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom: 01635 551422

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France: 01 48 65 15 59

Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com, as anonymous and use 

your Internet address, such as joesmith@anywhere.com, as your password. The support files and 

documents are located in the /support directories.
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Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a wide 

range of technical information. You can access Fax-on-Demand from a touch-tone telephone at 

512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mail at the 

Internet address listed below. Remember to include your name, address, and phone number so we can 

contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technical 

support number for your country. If there is no National Instruments office in your country, contact 

the source from which you purchased your software to obtain support.

Country Telephone Fax

Australia 03 9879 5166 03 9879 6277

Austria 0662 45 79 90 0 0662 45 79 90 19

Belgium 02 757 00 20 02 757 03 11

Brazil 011 288 3336 011 288 8528

Canada (Ontario) 905 785 0085 905 785 0086

Canada (Quebec) 514 694 8521 514 694 4399

Denmark 45 76 26 00 45 76 26 02

Finland 09 725 725 11 09 725 725 55

France 01 48 14 24 24 01 48 14 24 14

Germany 089 741 31 30 089 714 60 35

Hong Kong 2645 3186 2686 8505

Israel 03 6120092 03 6120095

Italy 02 413091 02 41309215

Japan 03 5472 2970 03 5472 2977

Korea 02 596 7456 02 596 7455

Mexico 5 520 2635 5 520 3282

Netherlands 0348 433466 0348 430673

Norway 32 84 84 00 32 84 86 00

Singapore 2265886 2265887

Spain 91 640 0085 91 640 0533

Sweden 08 730 49 70 08 730 43 70

Switzerland 056 200 51 51 056 200 51 55

Taiwan 02 377 1200 02 737 4644

United Kingdom 01635 523545 01635 523154

United States 512 795 8248 512 794 5678



Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, and use 

the completed copy of this form as a reference for your current configuration. Completing this form 

accurately before contacting National Instruments for technical support helps our applications 

engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem, 

include the configuration forms from their user manuals. Include additional pages if necessary.

Name __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) __________________________________________

Computer brand____________ Model ___________________Processor _____________________

Operating system (include version number) ____________________________________________

Clock speed ______MHz   RAM _____MB Display adapter __________________________

Mouse ___yes   ___no     Other adapters installed _______________________________________

Hard disk capacity _____MB Brand_________________________________________________

Instruments used _________________________________________________________________

_______________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration ___________________________________________________________________

National Instruments software product ___________________  Version  _____________________

Configuration ___________________________________________________________________

The problem is: __________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

List any error messages: ___________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

The following steps reproduce the problem: ___________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________



Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each item. 

Complete a new copy of this form each time you revise your software or hardware configuration, and 

use this form as a reference for your current configuration. Completing this form accurately before 

contacting National Instruments for technical support helps our applications engineers answer your 

questions more efficiently.

National Instruments Products

GPIB interface type and revision _____________________________________________________

GPIB software for Windows NT version number on disk __________________________________

Programming language interface version _______________________________________________

Shield ground connected to logic ground (yes or no) _____________________________________

Diagnostic utility results ____________________________________________________________

Board settings:

Other Products

Computer make and model __________________________________________________________

Microprocessor ___________________________________________________________________

Clock frequency or speed ___________________________________________________________

Type of monitor card installed________________________________________________________

Windows NT version_______________________________________________________________

Application programming language (Microsoft C, and so on) ______________________________

Other boards in system _____________________________________________________________

Base I/O address of other boards______________________________________________________

Interrupt level of other boards ________________________________________________________

DMA channels of other boards _______________________________________________________

Base I/O 

Address

Interrupt 

Level

DMA 

Channel

gpib0 _________ _________ ________

gpib1 _________ _________ ________

gpib2 _________ _________ ________

gpib3 _________ _________ ________



Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products. 

This information helps us provide quality products to meet your needs.

Title: Getting Started with Your AT-GPIB/TNT+ and the GPIB Software for Windows NT

Edition Date: January 1998

Part Number: 321820A-01

Please comment on the completeness, clarity, and organization of the manual.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

Thank you for your help.

Name _________________________________________________________________________

Title __________________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

E-Mail Address __________________________________________________________________

Phone ( ___ ) __________________________  Fax ( ___ ) _______________________________

Mail to: Technical Publications Fax to: Technical Publications

National Instruments Corporation National Instruments Corporation

6504 Bridge Point Parkway 512 794 5678

Austin, Texas 78730-5039
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Glossary

Prefix Meanings Value

m- milli- 10–3

c- centi- 10– 2

M- mega- 106

° degrees

% percent

A amperes

ANSI American National Standards Institute

ASIC application-specific integrated circuit

C Celsius

CPU central processing unit

DIP dual inline package

DMA direct memory access

EMI electromagnetic interference

FCC Federal Communications Commission

GPIB General Purpose Interface Bus

hex hexadecimal

Hz hertz

IEEE Institute of Electrical and Electronic Engineers

in. inches
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Glossary

I/O input/output

IRQ interrupt request

ISA Industry Standard Architecture

kernel set of programs in an operating system that implements basic system 

functions

m meters

MB megabytes of memory

PC personal computer

RAM random-access memory

s seconds

VDC volts direct current
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